For the Student
Lesson 5: Using a Template – a Two Page Newsletter

Introduction

During this lesson, you will learn to open an existing template file, modify it when needed, and create your own templates. You will continue the exploration of the uses of Paragraph text, particularly using text in columns and flowing text from column to column and page to page. You will also explore the various ways that graphics can interact with paragraph text. As an individual or part of a group, at the end of the exercises and research phases, you will create an original two or four page newsletter on the topic of your choosing or a topic assigned by the instructor.

At the end of the research and exploration phase, you should be able to answer several of the essential questions about using and editing templates and paragraph text in CorelDRAW. You may also explore the history of Lorem Ipsum text in design and possible modern replacements. Other avenues of research include the use of newsletters in social and marketing contexts and comparing them with blogs. Student groups may decide to make an ongoing project of periodic newsletters for the class or other student events.
Essential Questions:

These questions will help guide your explorations during this lesson.

CorelDRAW questions for this project. 
How do you use templates? How do you create your own template?

How can you make text flow from column to column and page to page?

How do you insert graphics into a text stream?

How do you make text flow around graphics?
Questions about creating and editing a newsletter:
What are the basic parts of a newsletter?

What makes a newsletter different from a brochure or magazine?

What are some design rules that need to be followed in an effective newsletter?
Questions about “filler text”:

Why would you use filler text?

What is Lorem Ipsum and how did it become the standard filler text?

Are there other things that can be used for filler text that might be just as effective?
Questions about the social and marketing uses of newsletters:

Who uses newsletters?

Why would newsletters be an effective form of communication?

Compare newsletters and blogs.

Assignments:

1. Students explore using templates and paragraph text using the tutorials and worksheets provided along with Help system articles.

2. Students work through Sample Project 5.

3. Students use the various tutorials and Sample Project 5 as a springboard for group discussion and research on copyright/ safety/ security/ ethical issues and methods of searching for appropriate photograhs, quoted text, information and other newsletter elements created by other people based on the Essential Questions. The teacher may break larger classes into groups and assign certain questions to each group. The groups should then report the findings back to the whole class. The teacher may also choose to lecture on some or all of these subjects.

4. Group research and discussion of the history and use of Lorem Ipsum or the social and marketing uses of Newsletters, and comparing/contrasting them to blogs in usage, history, and design. Groups should prepare to present their findings to the class.

5. Students use the information they have gained in Assignments 1-4 to create an original two-four page newsletter on the topic of their choosing or a topic assigned by the instructor.
Assignment 1 – Getting started with Templates and Paragraph text
Step 1 – Read about it
From the CorelDRAW User Guide or Help, work through the following articles:

Working with Templates or Chapter 12:Templates in the CorelDRAW X6 Guidebook.

Working with pages and layout tools


Printing Basics
Step 2 – Working with text and page layout exercise 1
Work through Text Exercise 1 included with this lesson pack.

Step 3 – Read and discuss

Read the Fundamentals of Design tutorial PDF included with this lesson. Look around your classroom, textbooks, and other available materials and discuss how the fundamentals are applied in each.

Step 4 – The New from Template Dialog
Open the CorelDRAW program. It should start with the Welcome Magazine as the splash screen. From the Quick Start page, choose New from Template. Alternately, choose New From Template from the File menu. From the Working with Templates article and tooltips, label the parts of the New from Template dialog on Worksheet #1.
Step 5 – Opening a Template

Browse through the various templates available. Open the Law Firm – Newsletter for the paper size you normally use – A4 or Letter (8 ½ x11 inches). Most likely you will get an error message telling you that you are missing the writing tools for the Russian language. You may safely tell the program that you do not want to install the language package.
Step 6 – Observe the Template design

The first thing you are likely to notice is that the Russian alphabet looks considerably different than the one you are used to. In some ways, that is good because it lets you focus on the design elements of the template. Answer the following questions:
1. Where do you think the title of the newsletter is displayed? Why would the designer put it there rather than at the very top center of the first page?

2. How are colors used differently on page 1 and page 2? How are they the same?

3. What elements are repeated on both pages? What does this accomplish in the design?

4. Notice the various sizes and colors of fonts. How are titles, headlines, articles, and contact information displayed differently?

5. Besides photos, what other graphical elements are included in the newsletter?
6. For what sort of market or audience do you think this newsletter is intended?

7. How does this newsletter apply each element of design from the design tutorial?

8. How are pages and layers used to organize the newsletter in the Object Manager?

Close this template without saving. Go to the File menu and choose New from Template. This time open the Consulting Newsletter template. Again, ignore the request to install the Polish language pack.
Answer the same questions above for this newsletter. How is the design of this newsletter different from the Law-Firm newsletter?
If you do not have these two templates, look at two newsletter templates that you do have available either on your computer or network or at the Corel.com site.
Assignment 2 – Using and editing a template – Project 5
Introduction
In this assignment, you will take an existing template and edit it to create a new newsletter with a different purpose. You will start with a newsletter from a Child Care business and end up with one suitable for a literary newsletter containing poems, essays, and book reviews. The title for the newsletter will be Changing Tides.
Step 1

Open the CorelDRAW program. Open the UK Childcare Newsletter template using the New from Template dialog. Browse to the folder containing these lesson materials to find it. If you get a Fonts missing dialog, substitute Brush Script and Futura or other suitable fonts for Freehand and Swiss.
Save this document as a new CDR document with a new name.
Notice that in this template, everything is on the same layer. You may decide to create a new layer set-up for your newsletter to organize things so that they make sense to you. You might use one layer for text and another for graphics and images.

Step 2
Another thing you may notice is that the colors in this newsletter are much brighter than the Law Firm or Consulting newsletters. Why do you think this is so? Consider the color scheme you will want to use for your newsletter.

Change the four red objects on Page 1 to a nice Ocean green. (Click the first one in the upper right corner, click the Ocean Green color well in the onscreen CMYK default palette. Click the next red object and use the keyboard shortcut Ctrl+R.) Change the deeper pink object in the upper left corner to a lighter version of the Ocean Green by clicking and holding the Ocean Green color well in the Onscreen palette until a larger selection of colors appears. In CorelDRAW X5 and X6, you can use the Document Color palette to help you with the color changes in this exercise.
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Choose the lightest shade on the same horizontal line from the current color and click on it to fill the object. Apply that same color to the light pink object by Ctrl+R. Finally, Ctrl drag the White color well over that same object (the one that used to be light pink) three times to add a total of 30% white to the color.
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On the right, change the bright aqua object to the Ocean green. Right click drag the middle color wave object from the left corner over the bottom wave object in the right corner and release. From the resulting dialog, choose Copy fill color here.
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If you are using CorelDRAW X5 or X6, you may want to place these colors in your document palette.
Step 3

Both photos in this newsletter have been cropped to a circular area with one flattened side near the edge of the newsletter. Each one has a curve outlining it. Use that curve to easily replace the bitmap but keep the same shape.

Delete the photo of the colored pencils on Page 1. Since it is placed below the circular curved object which you will want to keep, you’ll need to select it by either Alt clicking on it with the Pick tool or by selecting it in the Object manager. Either way, once it is selected, tap the Delete key on your keyboard.
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Step 4

Import photo PH00014.jpg from the Resources folder for this lesson. It looks like water ripples. Click once to place the photo anywhere on the work area. Scale it down to 50% using the Property bar.
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From the Bitmaps menu or the Property bar, choose Resample. Change only the Resolution to 100.
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That’s plenty for this exercise. You may wish to use a different resolution for your own newsletter, depending on your printing method. 90-100 is plenty for the Web. 150 is fine for any home inkjet or laser printer. For professional printing, you may want 200 or even 300.

Right click and drag the now smaller photo over the empty white flat-sided circle object from Step 3. (If you have Dynamic Guides turned on in the View menu, you’ll see the Edge tooltip pop up when you are in the correct place.) Release the mouse button and choose PowerClip Inside. The photo is now clipped to the shape of the object. Right click on the newly PowerClipped object and choose Edit contents. You’ll see the full photo and a dark blue outline of the container object. Move the photo around until an appropriate section of the photo falls within the outline of the container curve. Right click and choose Finish editing this level.
In CorelDRAW X6, there is a toolbar for working with Powerclipped contents that appears when a powerclipped object is selected.
At this point, the front page of your newsletter should look something like this:
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Click on the Page 2 tab at the bottom of the workspace to go to that page. Repeat the delete procedure above with the AB blocks photo at the bottom of the page. Import photo PH00035.jpg from the same folder. Using the property bar, resize the image to 50% in both directions and resample to 100dpi. Right click and drag the photo over the empty white object. Release the mouse button and choose PowerClip Inside.
You may not like where the photo was placed inside the object. Adjust it to something you prefer. For best results, the photo should usually be at least slightly larger than the container object in all directions.
When you have the photo in the position you want, right click again and choose Finish Editing this Level from the context menu. That should put you back into the main CorelDRAW workspace.
You should end up with something like this.
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Step 5
Return to Page 1 and choose the medium color from the top left three objects with the Eyedropper tool. Hold down the Shift key as you bring the eyedropper down to the rectangle behind the main area of text, but outside the paragraph text frame. When the Paintcan cursor changes to a solid square of your color (instead of an open square or null sign) click to change the color of the rectangle. Alternatively use the colors from the Document Palette in CorelDRAW X5 or X6.
Change the light square shape with the hole in it at bottom right to the lightest color from your wave objects at the top of the page. Change the Newsletter name to the same dark blue as the top right.
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Open the Color Styles docker at this point. (The Color Styles docker in CorelDRAW X6 works a bit differently. Read the help on using this docker and the Object Styles docker and the Guidebook, Chapter 9 on using Styles and Style Sets. Continue to use the Document palette to change the colors on the second page, then create styles and style sets for your newsletter.) You should see a folder with the name of your file. Double click on that folder to open it. You will probably see a combination of the colors you have added to the page and the colors that were there originally. Select each color and delete ALL of them. Once that is done, select ALL objects on your page (Ctrl+A) then click the Automatically Create Color Styles icon at the top of the Color styles Docker. Make sure all check boxes are checked and the Parent creation index is set to the default 50. If you click the Preview, you will see that there are two parent colors that will be created and one individual color. Opening the Grayscale parent shows child colors of black and white. Opening the Cyan parent color shows the Ocean Green and the two lighter shades you created. (When you click on the Preview, and when you click OK from the dialog, you may see a message stating that The object(s) you have selected contains color(s) which are color styles. They will not be re-added. This is OK.)
Go back to Page 2 now, and with your Color Styles docker still open, drag the Ocean Green color swatch from the docker onto the deepest yellow object. Similarly drag the medium shade to the middle shade of yellow, and the lightest shade to the lightest shade of yellow. Replace the red and pink objects at the bottom with the Ocean Green and the middle shade respectively. Replace the Aqua rectangle behind the largest text area with the middle shade.
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Now you may be wondering what good the Color Styles docker will do your newsletter that the eyedropper or other methods would not. Return to Page 1. Select the Cyan parent color swatch in the docker. Drag the Green color well from the onscreen palette over the Cyan parent color swatch in the docker and release it. The three child colors change in the docker, and so do every instance of them on both pages of the document! This is an easy way to keep a consistent look to your Newsletter from edition to edition, but still change colors throughout easily.
You can decide if you’d rather work with the Cyan version or the Green version from here out to the end of the exercise. If you want the Cyan version, simply drag the cyan color well back instead of the Green one.
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Save your work!

Step 6
Return to Page 1 and change the words Children’s Delight to Changing Tides. Do the same on Page 2. 
Simply delete the butterfly graphic from Page 1 and the top and bottom of Page 2. If you wish, you could choose some other graphic or symbol from a symbol font to go in those places, but for the litterary newsletter it isn’t really needed. An open book symbol might be a good echo of the tides/waves in the other parts of the newsletter.
Step 7
Notice the red frame around the large text frame on Page 2. In the original A4 paper size version of this template, the frame was longer. This red frame tells you in a glance that there is more text than will fit in the frame. Click once in the frame with the Pick tool and drag the bottom handle straight down with the mouse. More words will appear and if you have increased the frame size large enough, the frame color changes from red to black or dark blue.

Back on Page 1 delete the text in the dark blue frame and replace it with the words below:
Time and tide wait for no man, but we hope these poems and articles may give you pause to stop and think as the tides change.

Step 8
In the paragraph frame at the bottom right, place the following text:
Changing Tides is a publication of the literature department students.

Type your name, the class name, and any other information your instructor may require. Adjust the size and font so that it all fits. Repeat the process for the information area on the back page.
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Save your work.

Use the text areas on the squarish “color chips” to highlight upcoming events. Instead of Flexible Hours you could place the title or genre of a short poem or two to fit in the small text frames at the top. Book reviews could go in the larger text frame at the bottom, and a very short story or a poem could be placed in the large text area on page two. A shorter poem might go in the smaller text frame on Page 2.
It might be good for a story format to make the text frame a two column text area. Select the frame with the Pick tool, then from the Text menu, choose Columns. Choose two columns from the dialog and OK.
A longer story could be started in the large frame on Page 1 and flowed into the frame on page 2.
You will notice that in the examples for this exercise, the Lorem Ipsum text is substituted freely in place of actual content. You can use that same technique when setting up your newsletter. The Lorem Ipsum allows you to concentrate on design without having to have the actual content ready ahead of time and without being distracted by the content.
In this exercise, you started with a template, then changed the colors, images, and text to repurpose the template for another use. At times, you may want only certain elements of a template to combine with other elements from other templates. You may wish to add decorative elements to the text, inserting drop caps or graphics. If you wish to insert a graphic into the text so that the text flows around it, place the graphic where you would like it, then choose Wrap Paragraph Text from the right click context menu or the property bar. Pick the option for wrapping that best fits your intention. This will only work for closed curves and bitmaps such as photos.
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If you would like to insert a small graphic object into the actual line of text and the symbol you want is not available as a symbol font, create the object, select it with the Pick tool and Copy from the Edit menu, switch to the Text tool and insert the text cursor where you want the symbol and paste. A small copy of the symbol in the same size as your font will be pasted into the text.
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Results may vary as to how satisfactory the pasted graphic looks.

Save your final newsletter!

Finally, review the Help documentation again on Creating templates and save your resulting newsletter as a template.
Assignment 3

Use the various tutorials and Sample Project 5 along with the Essential Questions as a springboard for group discussion and/or research on copyright/ safety/ security/ ethical issues and methods of searching for appropriate photographs, quoted text, information and other newsletter elements created by other people.

Your instructor may break larger classes into groups and assign certain questions to each group. The groups should then report the findings back to the whole class. The teacher may also choose to lecture on some or all of these subjects.

Assignment 4

Use the various tutorials and Sample Project 5 along with the Essential Questions as a springboard for group discussion and/or research on one or more of the following topics:
1. What is the history of the Lorem Ipsum text and why is it used?

2. What are some social and/or marketing uses of newsletters? What makes them effective communication devices and marketing pieces?

3. Compare and contrast newsletters to blogs and other electronic social media in usage, history, and design.

Groups should prepare to present their findings to the class.

Assignment 5
Use the information you have gained in Assignments 1-4 to create an original two or four page newsletter on the topic of your choosing or a topic assigned by your instructor. Create a new template for this newsletter design. You may start with an existing template and edit it to suit your purposes. Take into account the basic elements of design as you plan the newsletter layout and graphics. Consider your printing options and the paper size you will be using as you design your template.
If this is a group project, within the group appoint people or work together to decide the topic, the design, and to find or produce written and graphic content.

If the newsletter will continue to be produced in the future, decide what elements will remain constant and which ones will change. If this is not a continuing project, use your template to produce a second newsletter as if it were a future newsletter, but insert Lorem Ipsem text and sample images in place of the changeable elements from the first version.
The following elements will be required in your newsletter:

1. Headlines should be easily readable, contrast with article text, and article headings should adequately summarize the content.

2. Included paragraph text should include the following elements:

a. Text flowing from column to column

b. Text flowing to continue on another page

c. Text flows around at least one graphic
d. Two or three columns
e. At least two pages, no more than 4.
3. At least three graphical elements are included as content other than those in the Sample project, whether photos, charts, clipart, character symbols or original drawings. This is beyond elements essential to the design such as color blocks and underlines. All graphics should relate to the topic or be an essential design element
4. At least one full article contains real content (not lorem ipsum or other filler text) relevant to the topic of the newsletter.
